ECE 4112 Internetwork Security

Lab 3: Address Spoofing and Denial of Service
Group Number:_____________
Member Names: ______________________   _______________________        
Date Assigned: January 31, 2006
Date Due:  February 7, 2006
Last Edited: January 26, 2006
Please read the entire lab and any extra materials carefully before starting.  Be sure to start early enough so that you will have time to complete the lab.  Answer ALL questions and be sure you turn in ALL materials listed in the Turn-in Checklist ON or BEFORE the Date Due.  
Goal:  This lab will introduce you to the concepts of falsifying identity on a network. Firewalls are often programmed to only accept traffic from certain IP and MAC addresses, so by falsifying this information a hacker can avoid this security. After successfully spoofing addresses, this lab will demonstrate how spoofing can be used for several kinds of denial of service attacks.

Background and Theory:  The data link layer protocol used on this network is Ethernet. Each Ethernet device, such as a wireless card or the network interface card in the back of the lab computers, is assigned a six byte unique Media Access Control (MAC) address when it is manufactured. When the device is placed on a network, this unique address is its identification. Different computers on a given Ethernet communicate with each other by sending messages to the destination MAC address. 

The predominant network layer protocol that drives most modern networks is the Internetwork Protocol, or IP. Every computer on the Internet has a unique 32-bit IP address which is assigned when the computer connects to the network. The IP address serves as identification of the computer on the global level, so any host can contact any other on the entire Internet using this address. 

Translation between MAC and IP address occurs through Address Resolution Protocol, or ARP. A host sends a message to its local Ethernet, asking what the MAC address is for a certain IP. If the destination IP is on its network, the destination responds with its MAC address.  

When a computer attempts to contact another with an IP address on its local subnet, it contacts the destination with ARP to determine the destination’s MAC address then sends a packet to the Ethernet MAC address. When a computer attempts to contact another off of its subnet, it uses ARP to determine the MAC address of its gateway router, and sends the packet to the router.  The router then uses the destination IP to connect between networks to the destination’s gateway router. Finally, the destination router uses ARP to determine the MAC address of the destination IP, and sends the packet across Ethernet to the destination.

MAC and IP addresses serve as unique identifiers of devices on a network, and are therefore used for security and identification. If someone is doing illegal things on the Internet, their IP address can be used to identify who they are. Law enforcement can subpoena ISPs for the user attached to an IP address at a certain point in time, and more recently the RIAA has been using IP addresses to determine the identities of file sharers. 

There are several possible uses of forging a MAC or IP address. Because firewalls trust IP addresses, it is possible to circumvent firewall security by making packets appear to come from an acceptable host. Because these addresses are used for network communication, however, forging an address breaks two-way communication. A “blind” IP attack, where the source spoofs its IP address, may mean that data is sent to a destination, but the source will not be able to see any replies from the data because replies will be sent to the spoofed address, not the actual address of the attacker. A “non-blind” attack, where a source spoofs its IP but can still see the replies, is only possible if the source and destination are on the same local network, so the attacker can sniff the network and still see the reply packets as they travel to the spoofed source or the gateway router. 

As it cannot be used to receive responses or gather data, IP spoofing is frequently used for Denial of Service (DoS) attacks rather than hacking to gain illegitimate access. A DoS attack is a malicious attempt to disallow legitimate users of system from successfully accessing it. This is most frequently done by flooding the target with data so that it will either overload and crash, be forced to drop legitimate requests due to buffer overflows, or simply not process legitimate requests in an acceptably timely manner. It can also be accomplished by destroying the foundation of network communication by sending intentionally flawed or deceptive messages.

Prelab Questions:  None

Lab Scenario:  This lab will be using all three of your virtual machines and an external FTP Server (57.35.6.200).
Section 1: MAC address spoofing

The MAC address for a network interface is assigned by the hardware manufacturer at the time of manufacture. Addresses are therefore completely independent of the network to which they are attached, and addresses can be spoofed with relative ease. This spoofing has the potential to undermine common security measures. OIT, for example, uses MAC addresses on ResNet and on LAWN to tie network traffic to particular students. (Students tell OIT their MAC address when they register on ResNet or log into LAWN). By forging another student’s MAC address, OIT could be led to believe that your malicious activity was actually that of another student. As another example, many wireless routers only allow access from an allowed list of MAC addresses so that only certain computers can access the wireless network.  

Exercise 1: Windows XP MAC Cloning

Inspect the current MAC and IP address:

1. Open a Command Prompt

2. Type the command ipconfig /all
3. Record your results (either as a screen shot OR as a text file)


(Attachment 1)
Change the MAC address

1. From the “Start Menu” go to Control Panel->Network and Internet Connections

->Network Connections

2. Double Click the icon labeled “Local Area Connection”

3. Click on “Properties”

4. Click “Configure,” which is under the NIC hardware.

5. Choose the “Advanced” tab

6. Highlight the “Network Address” field and input 12 hexadecimal characters to create your new MAC address.  Example: 000393B967F6 OR 003065242130
7. Run ipconfig /all again and record your results.

 
(Attachment 2)

You may want to use ethereal and initiate some network traffic to “see” the new MAC address being used. Go back to the configuration and remove your changes. 

Exercise 2: Linux MAC Cloning 

Inspect the current MAC and IP address:

1. Type the command ifconfig eth0
2. Record your results (either as a screen shot OR as a text file)


(Attachment 3)

3. Type the command ifconfig eth0 down
or use the Linux command ifdown eth0

4. Type the command ifconfig eth0 hw ether 00:30:65:24:21:30
(or an Ethernet address you create) 
5. Type the command ifconfig eth0 up

6. Type ifconfig again and record your results (either as a screen shot OR as a text file) (Attachment 4)
7. Change your MAC Address back to the original one.
Q1.1:  What would happen if two hosts on the same network had the same MAC address?


Q1.2:  Although it is relatively simple to forge a MAC address, it is very difficult to determine the MAC address of a host on a subnet to which you do not already have access. Why is this true? 
Section 2: IP spoofing from Windows

Start your Linux 7.2 and Windows XP virtual machines, and in Windows connect to the Network Attached Storage (You should know how to do this from Lab 1). Copy the file \\57.35.6.10\secure_class\Lab3\winject.zip to your local computer. Extract it to a new folder, then open the wINJECT application.

1. Click the “settings” button under “misc” header.

2. Choose “static” connection from the “Connection” drop down list.

3. Choose the IP of the WinXP virtual machine from the “Current IP” drop down list. 

4. Click “Save” to save your settings.
We are going to send our spoofed packets to the daytime-udp server on the Red Hat WS 4.0 machine. This server is run on UDP port 13 and replies to any incoming UDP packet with the current date and time on the system. Install the service on your Red Hat WS 4.0 machine by doing the following: 
1. Edit the file /etc/xinetd.d/daytime-udp by changing disable = yes to disable = no.

2. Restart xinetd by running:

/sbin/service xinetd --full-restart

Since daytime-udp will respond to any UDP packet, send a pre-defined packet. Press Packet->Open in wINJECT, then select DNS_Q.PKT in the packets folder. Edit four fields before sending the packet:


IP_Src : IP Address of your Linux 7.2 Machine (Format: IP)


IP_Dst : 57.35.6.255 (Format: IP, the Broadcast address of the lab subnet)


udp_sport: 8000 (Format: Dec, a generic port)


udp_dport: 13 (Format: Dec, the port of daytime-udp)

On your Red Hat WS 4.0 Machine open Ethereal and begin capture. Then return to Windows XP and press “Inject Packet” several times. Observe the results in Ethereal and answer the following questions.

Q2.1. What machines appear to be involved in the daytime-udp query? Who is    querying whom, and who is answering whom? 

Q2.2. For every packet injected, how many appear in Ethereal?  Explain.

Q2.3. Note the destination IP address of your spoofed packets. How do other groups working on this lab affect the attack? (Note: this is known as a smurf attack)
Q2.4. Was this an example of blind or non-blind IP spoofing? Why?
Section 3: IP spoofing from a Linux machine

3.1 UDP Spoofing
Just as we can create arbitrary IP packets in Windows, we can do the same in Linux. Because Linux offers simple access to network C libraries, it is relatively simple to code packets and send complex DOS strings. 

From RedHat 7.2, connect to the Network Attached Storage and copy the file Lab3/fraggle.c to your local machine. Carefully read through the code to understand its functionality. Compile fraggle with

#gcc -o fraggle fraggle.c

The Fraggle program spoofs a stream of UDP packets seemingly from a given source to a list of destinations.  Create a file (e.g. addresses.txt) and add the IP address of your Windows XP virtual machine followed by a carriage return.  

Start Ethereal on your Red Hat WS 4.0 Machine, then execute fraggle on your RedHat 7.2 machine so that 10000 packets are sent seemingly from your Red Hat WS 4.0 Machine. First check the syntax by typing: ./fraggle
Example:
./fraggle 57.35.6.yyy addresses.txt 10000 0

Where 57.35.6.yyy is the target address (the apparent source ip of the packets) 

Q3.1.1. Copy a sample line from your Ethereal output. What machines appear to be the source and destination of this transmission? 
Now edit fraggle.c to demonstrate how simple it is to manipulate the contents of an IP packet. In the void method fraggle, the entire IP packet is pointed to by char *packet. Add code so that the UDP payload includes the string “ECE4112.” Recompile fraggle, and rerun the above test, verifying in Ethereal that you were successful in modifying the UDP datagram. 

Q3.1.2. What code changes were necessary?

Q3.1.3. Copy the ASCII representation (bottom right display from Ethereal) of your created packet. 
3.2 TCP Spoofing
Now we will use TCP packets to accomplish the same task. From RedHat 7.2, connect to the Network Attached Storage and copy the file Lab3/stream.c to your local machine. Carefully read through the code for stream.c to understand its functionality. Compile the program with 

#gcc –o stream stream.c
“Stream is a resource starvation attack taking advantage of the operating system’ inability to manage malformed packets sent to it at once. Stream works by sending TCP ACK packets to a series of ports with random sequence numbers and random source addresses” (Hacking Exposed, 3rd Edition, p.516).

Start Ethereal on your Red Hat WS 4.0 Machine, then execute “stream” on your RedHat7.2 machine against your Windows XP machine. 

Note: Only allow ethereal to run for 1-2 seconds because a huge amount a packets will be generated by stream.

# ./stream [ip of the WS 4.0 machine] 0 0

Screenshot #1 – Take a screen capture of your ethereal output.
Now edit stream.c to demonstrate how simple it is to manipulate the content of a TCP/IP packet. Add a string of data to the packet that reads “ECE4112 – group N”, where N is your group number.
(Hint: You will need to edit one of the structs and one or more of the functions.)

Q3.2.1 What code changes were necessary?

Now, compile and run the stream attack again. Run ethereal for a few seconds. In ethereal, highlight a packet that shows the string you added.

Screenshot #2 – Take a screen capture that shows the highlighted packet.

Section 4: DNS Spoofing and Denial of Service

In our next spoofing example, we will look at another method of spoofing that takes advantage of the network protocol stack. Many Internet applications make use of the Domain Name System (DNS), so that hard to remember and possibly dynamic IP addresses (e.g. 66.35.250.151) can be mapped to easily remembered ASCII names (e.g. www.slashdot.org). In the last lab you observed that by forging ARP messages, a victim could unknowingly communicate with the wrong MAC address. Using a similar man in the middle attack, forging a DNS message can cause a victim to communicate with the wrong IP. 

First start your web server on your Red Hat WS 4.0 Machine (the one installed in Lab 2) by typing

# /home/apache2/apachect1 restart

Test your Server by opening a web browser (type mozilla) and going to http://localhost/ . You should see a test page. 

Next install a DNS spoofing tool on your Red Hat 7.2 machine. Copy the files dsniff-2.3.tar.gz, libnet-1.0.2a.tar.gz, and libnids-1.16.tar.gz from the Network Attached Storage to your local Red Hat 7.2 machine. 

Install the tools by typing:

#tar zxvf libnet-1.0.2a.tar.gz

#cd Libnet-1.0.2a

#./configure && make && make install

#cd ..

#tar zxvf libnids-1.16.tar.gz

#cd libnids-1.16

#./configure && make && make install

#cd ..

#tar zxvf dsniff-2.3.tar.gz

#cd dsniff-2.3

#./configure && make

#make install
Ignore the generated errors. Although some of the dsniff files will not compile under Red Hat 7.2, the programs we will use will. 

To setup DNS entries to spoof, type

#echo “[your ip] windowsupdate.microsoft.com” > hostfile

To add additional entries, simply edit the hostfile file.

Start the application by typing

#dnsspoof –i eth0 –f hostfile
DNSSpoof will now listen on the eth0 interface and forge DNS replies for any request to a host in hostfile.

In your Windows XP Machine, open Internet Explorer and go to http://windowsupdate.microsoft.com
(Depending on your current computer load and because our DNS server delay is so small, you may need to try this multiple times)

Q4.1:  What are the results of trying to reach Microsoft’s Windows Updater?

Q4.2:  In the case of our local network, you may have had to try this several times. Why? (Hint: Observe transactions in Ethereal)

Q4.3:  Copy the output of DNSSpoof

Q4.4:  Keeping in mind that this attack is only possible if executed between a host and its DNS server, state three instances in which a hacker could use this attack. (You may wish to consider this with respect to the Blaster worm, or with respect to the Georgia Tech LAWN’s logon page). 
Section 5: Monitoring for Spoofing Attacks

In sections 1 and 2 we observed how to spoof a MAC address. Using methods similar to those of section 4, we could also spoof ARP messages in order hijack a connection. It is important that a network administrator be able to monitor the network for such attacks, known as ARP Poisoning, in order to prevent a successful hack. 

One way to prevent ARP poisoning is to monitor the network and check for consistency in ARP messages. If an IP address is claimed by one MAC address, and later that address is claimed by a different address, it is possible that ARP messages are being spoofed, sending a victim to the wrong MAC address. Similarly, if a MAC address is assigned one IP and then is changed to another, it is possible that a hacker has changed his or her MAC address, possibly for malicious purposes.

From Red Hat WS 4.0, copy Lab3/arpwatch.tar.Z from the NAS server to your local drive. Type the commands:

#tar –zxvf arpwatch.tar.Z

#cd arpwatch-2.1a4

#./configure && make && make install

Start arpwatch so that we can monitor for changes. Under the default configuration, arpwatch will email results to the system administrator. We would rather simply print the output to the screen so type:

#./arpwatch –d

In RedHat 7.2, ping your Red Hat WS 4.0 machine.

Q5.1:  Copy the arpwatch output. 
Return to RedHat 7.2, and change your machine’s MAC address as we did in Section 1. Ping your Red Hat WS 4.0 machine again.

Q5.2:  Copy the new arpwatch output.

arpwatch, as shown, serves only as a detective tool, telling a system administrator when there may be a network vulnerability. The network administrator is then responsible for interpreting the warning and deciding to act or not. On Resnet, OIT uses an automated approach. If two computers appear on the network with the same MAC address, the MAC address will be automatically banned until a Resnet employee overrides the ban. 

Section 6: TCP Spoofing and Denial of Service
In our final spoofing section we will discuss sending malicious TCP packets in order to break existing TCP sessions. TCP is a connection-based protocol. Before communication can take place, a connection must be established between the source and the destination. This is done with what is known as a three-way handshake: the initiator sends a SYN message, the destination replies with acknowledgement ACK and another SYN, then the original initiator sends an ACK for the second SYN. When the communication is complete, the TCP session is terminated with a similar handshake, this time with the FIN flag. 

FTP uses TCP to communicate and we will use this for our attack.  In Red Hat 7.2, type ntsysv in a command shell. Find [ ] wu-ftpd and make sure it is [x] checked. Click OK. In command shell, type /etc/init.d/xinetd restart.  With the useradd command, add a user to your Red Hat 7.2 system so that you can log in remotely (you cannot FTP in as root). 

Open Ethereal on your Red Hat 7.2 machine to observe the connection. Log into Red Hat WS 7.2 from Windows XP by opening a Windows command prompt and typing  ftp <RH7.2 IP> . Type a command, such as ls to make sure that your connection is active. Type bye to quit.

Screenshot #3 – Observe and take a screenshot of your Ethereal output by pressing the print screen button on your keyboard. Take note of the three-way handshake initiating the connection and the four-way handshake terminating the connection.  

We will now use tcpkill application, installed with dsniff.  tcpkill monitors the network for TCP applications and will spoof RST messages to terminate open connections. 
Install tcpkill by typing

#make tcpkill
in the dsniff directory.

Start Ethereal, then open an FTP session into Red Hat 7.2 from Windows XP. As we do not want to completely destroy TCP connectivity for everyone on our network, disconnect the Ethernet cable from the back of your computer.
Type 

#./tcpkill tcp port ftp

This will make tcpkill look for ftp connections to spoof and kill. Return to Windows XP and type ls . Notice that your connection has been terminated. 

Stop Ethereal and observe your output. Stop tcpkill and observe its output. 
(Screenshot #4)  Take a screenshot of your Ethereal output that includes the spoofed RST packets. 
Copy your tcpkill output to a text file. 

Q6.1:  Describe the tcpkill output. What are the numbers represented in the output? (Hint: you may want to correlate these messages with the Ethereal output)

Q6.2:  Although this is a simple attack, it cannot be used by a hacker to arbitrarily break Internet connections. Why not?

Reconnect the Ethernet cable in the back of your computer. 

Q6.3: E-mail spoofing occurs when the header of an e-mail message is changed so that the message appears to have originated from somewhere else. This is a technique that most spammers use. Why is e-mail spoofing possible? (Hint: look at the protocols that allow e-mail communication)
Section 7: Denial of Service Attacks

Our previous denial of service attacks have been limited to attacks on ones own local network. In this section we will observe how to prevent legitimate access to our Red Hat WS 4.0 FTP server from any network using several denial of service techniques. If you do not have wu-ftp installed on your host (WS 4.0) machine, follow the following instructions:

· Copy the wu_ftpd rpm file from the “/mnt/nas4112/Lab2/tools” directory to the tools folder “/home/tools”
· In the “/home/tools” directory, type “rpm -i wu_ftpd_file”, where wu_ftpd_file is the full name of the rpm file

· Next type “ntsysv”. Scroll down to wu_ftp and press space to check it. Press Tab and Enter on OK

· Now type “/etc/init.d/xinetd restart”

· This will start the ftp server

In RedHat 7.2, copy the file Lab3/datapool3.3.tar.gz from the Network Attached Storage to your local machine. Type 

tar xzvf datapool3.3.tar.gz
to extract the file, then cd datapool to enter the datapool directory.

Datapool is a powerful DoS tool that includes 106 DoS attacks. To view the possible command line options, type:

./datapool.sh

The first attack we will observe is the TCP SYN attack. This attack floods a TCP service, such as FTP, with SYN packets, which are used to initiate a connection. The service can only maintain a finite number of connections, so these false SYNs exhaust the service’s capabilities and prevent legitimate TCP connections. The datapool attack we will use is entitled synful.  

From your Windows XP machine, FTP into your Red Hat WS 4.0 machine. From your Red Hat 7.2 machine, execute datapool.sh with your WS 4.0 machine as the destination, 21 as the port, a continuous attack, T3 as your line speed, and executing exclusively synful. Use the command below. 
./datapool.sh  –c  –d 57.35.6.x  –p 21-21 –l T3  –r <nameofattack>
Start Ethereal on your Red Hat WS 4.0 machine, then attempt to execute commands from your Windows XP FTP session. Stop Ethereal and observe the Ethereal output. Close your FTP session.

Without stopping the SYN attack, restart Ethereal then try to FTP into the WS 4.0 machine once again.  Stop Ethereal and observe your results. Also, open a new terminal window in the Red Hat WS 4.0 machine and type the following command:
netstat –an | grep SYN

If you do this, it should show you the pending connections waiting in the SYNRECVD state. Note that not all of these are necessarily SYN attacks! A slow dial-up user, who is a few seconds away from you IP-wise, will show up as a pending connection request for a few seconds. If you see tens of connect attempts to a particular service (port 23, 25, 110, 119, etc) from very random looking source addresses, then you have cause to suspect you’re being attacked. 

There are some simple approaches to fixing the SYN problem:

1. Decrease the length of time that pending connections are allowed to sit around in the OS queues. 

2. Increase the length of the queues (linked-lists, actually)

3. Use better kernel data structures to store the list of pending connections

Syn flooding requires the attacker to continually send a large number of TCP SYN packets to the target. For each SYN packet received, the target host sends an acknowledgement packet toe the supposed sender. The target then waits for a reply to the 

Ack; however, the attacker never sends the reply causing the target to continue to wait. These ties up a buffer on the target host system. When all buffers are used, no further network connections to the target are possible. Eventually, the waiting connection will time out, the kernel will free the buffer and make it available for new connections. Because of the high volume of packets sent during a syn flood, an attacker’s packets are more likely to use the buffer than a packet from a legitimate connection. In this attack, the attackers must spoof the source addresses from hosts that are non-existent or inactive. If the source address is of an active host, because this host did not send the initial SYN packet, when it receives the ack packet from the target, it will reply with a reset and thus release the waiting slot. 

Q7.1:  Were you able to execute commands from your first FTP session? Were you able to execute commands in your second FTP session? Why or why not?

Q7.2:  Describe your Ethereal output. What sources appear to be sending data to your FTP server? How is your FTP server reacting? Are its responses consistent? 
The next attack we will observe is the teardrop attack, appropriately named teardrop in datapool. This attack takes advantage of IP’s ability to be fragmented as it is sent across a heterogeneous network. Ethernet, for example, can support 1500 byte packets, while ATM can only support 48. When the IP packet move from Ethernet to ATM, they must be fragmented into many packets and then reassembled later.

The teardrop attack puts incorrect values in the IP fragment ID. The receiving system, if it does not know how to handle these inconsistencies, may experience buffer overflows or may crash. 

Use datapool to execute the teardrop attack using the same parameters as you did for synful. In Windows XP, attempt to FTP to your Red Hat WS 4.0 machine. In Red Hat WS 4.0, open Ethereal and capture a few seconds of data. Stop datapool using <ctrl-c>.
Q7.3:  Were you able to create an FTP session? Why or why not?

Q7.4:  Describe your Ethereal output
Finally, we will observe a UDP flood attack, appropriately named udpflood in datapool. UDP is a connectionless Transport Layer protocol, and its lack of flow control allows a tremendous amount of data to be placed on the network at once. TCP, the protocol used for web, ftp, mail, and many other kinds of traffic, has flow control and will send less data when there is a heavy network load. A UDP flood attack sends massive amounts of UDP data, therefore filling the network and preventing successful TCP traffic flow.  

Use datapool to execute the udpflood attack using the same parameters as you did for synful. In Windows XP, attempt to FTP to your Red Hat WS 4.0 machine. In Red Hat WS 4.0, open Ethereal and capture a few seconds of data. Stop datapool. 

Q7.5:  Describe your Ethereal output. 
Chances are, you were able to successfully create an FTP connection. This is because the virtual network among our virtual machines has infinite bandwidth: it is impossible to fill up the network pipe and choke TCP. 

Using your Ethereal data, calculate the rate of UDP traffic generation. You can do this by observing the number of UDP packets sent during your collection time, the length of your collection time, and the size of each UDP packet. Keep in mind that network traffic is the number of bytes that must go across the Ethernet wire, not just the number of bytes in your UDP datagrams. 

Q7.6:  What is the rate of UDP traffic generation in Mbps?

Q7.7:  Assume that a victim server has a 1Gbps connection to the network. In a distributed DoS attack, how many of your traffic generators would be necessary to completely overwhelm this connection? (Note: In a real world attack nowhere near this many is required, as this is an extremely inefficient generator and networks may fail from a buildup of collisions at as little as 60% utilization). 

This local attack has shown us the worst damage we can do with our udpflood. Now we will see what happens when we attack a limited system. Before you begin, make sure that no one else in lab is currently working on this attack. From Windows XP, FTP into a Linux FTP server we have set up at 57.35.6.200 (username and password secure_class). This machine only has a 10Mbps connection to the network. Start the udpflood attack from the Red Hat 7.2 machine  directed towards this server. Start Ethereal on your Red Hat WS 4.0 machine, then attempt to execute commands from your Windows XP FTP session. Stop Ethereal and observe the Ethereal output. Close your FTP session.

Without stopping the flood attack, restart Ethereal then try to FTP into our server machine once again.  Stop Ethereal and observe your results.

Q7.8:  Were you able to execute commands from your first FTP session? Were you able to execute commands in your second FTP session? Why or why not?

Look through datapool.fc, and choose one more DoS attack that looks interesting to your group. Run the attack, attempting to log into the FTP server and collecting Ethereal data as in the previous attacks. (Note: not all of these attacks will work on the lab setup due to missing libraries. This will result in no or few packets being noticed by Ethereal.)

Q7.9:  Were you able to create an FTP session? Why or why not?

Q7.10:  Describe your Ethereal output.
Q7.11:  Compare and contrast the relative effectiveness of the four attacks.

Section 8: Email Spoofing
8.1 Sendmail Spoofing

Sendmail is an open source mail transfer agent (MTA): a computer program for the routing and delivery of email. Its authors released the current version, Sendmail 8.13.3', on January 11, 2005. Sendmail acts as a mailer daemon for UNIX and Linux. It allows a user to send email to other email servers as well as allows other email servers to send mail to it and the users that belong to it.

In this lab we will set up a mail server and create users on this servers. We will then show how anyone can connect to this server and spoof mail between two legitimate users on this server. Start up the Redhat7.2 virtual machine and do the following.

Configuring and setting up a sendmail server

# vi /etc/sendmail.cf

Type in  “/127.0.0.1” and press enter. This will search for the string “127.0.0.1” in the file and will show you the first occurrence of it. Replace this with 0.0.0.0, save and close the file. Save (Esc : wq)

Start the sendmail service

# service sendmail start
Creating users on your mail server.
Add the following users to your mail server by using the adduser command:
# adduser authuser

# adduser henry
Set passwords for each of these users:

# passwd authuser

# passwd henry

We will now send a legitimate mail from the authorized user auth user to henry. We will use the pine mail client program for this.

Pine® - a Program for Internet News & Email - is a tool for reading, sending, and managing electronic messages. Pine was developed by Computing & Communications at the University of Washington. Though originally designed for inexperienced email users, Pine has evolved to support many advanced features, and an ever-growing number of configuration and personal-preference options. Pine is available for Unix as well as for personal computers running a Microsoft operating system (PC-Pine).
[http://www.washington.edu/pine/]
We switch user to the authorized user’s shell. We can do this because we are root.
# su authuser
$

We then open pine for this user and send out a mail to henry.

$ pine

In the main window Press E to bypass the first screen. Select compose by using the arrow keys and pressing Enter. Compose a mail to henry as below:

To      : henry@localhost

Subject : Test

Hello Prof Owen, This is my new mailing address for the ECE4112 Class.

Press Ctrl+X to send this message and then q to quit. Exit back to the root shell as follows:

$ exit

#

We will now check henry’s mail to see if he got it.
# su henry

$ pine
Again press E as before and then press Enter twice to see the inbox and enter on the first message to read it. You should see a mail from “authuser@redhat7.2”. Exit pine as before by pressing q.

Now minimize the Redhat7.2 Virtual machine and go back to your RedHat Workstation Hostbox. Open a shell and type in the following:

$ telnet group-ip+1 25

Here we are connecting to the sendmail server which runs on default smtp port 25. Then type in the following.
HELO redhat7.2

250 redhat7.2 Hello [hostbox-ip], pleased to meet you

MAIL FROM: authuser@redhat7.2

250 2.1.0 authuser@redhat7.2... Sender ok

RCPT TO: henry@redhat7.2

250 2.1.5 henry@redhat7.2... Recipient ok

DATA

354 Enter mail, end with "." on a line by itself

SUBJECT: I Know

I know what you did last summer!!!

.

250 2.0.0 j8JHwT727027 Message accepted for delivery

QUIT

221 2.0.0 redhat7.2 closing connection

Connection closed by foreign host.
Screenshot #5 Attach a screenshot of the above session

Now go back to the redhat7.2 virtual machine and open henry’s mailbox. Try and distinguish the first mail from the second.

Screenshot #6 Take a screenshot of pine showing both the messages
8.2 Spoofing Emails through Remailers

Go to the website from a computer outside the ECE network (the ECE firewall blocks this ip):

http://www.elitec0ders.net/afteranonimousmail.htm
You will see something similar to the image below.
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Fill in the blanks and send your self an email. An example is shown bellow where a fake Administrator is asking a user to change his password at once and treating his account.
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Take a screenshot of the faked email you received (Screenshot #7).
A person that does not have idea what is happening will change his password. However, you can verify where this email is coming from. In gmail (if you have an account), click “more options” > “Show original” once here, you will see something similar to the code below:

X-Gmail-Received: fa37e1e6c2cb82e2399f30896200762921a2efbd

Delivered-To: xxxxxxxxxx@gmail.com

Received: by 10.65.105.6 with SMTP id h6cs25110qbm;

        Mon, 19 Sep 2005 22:08:06 -0700 (PDT)

Received: by 10.36.57.15 with SMTP id f15mr2898079nza;

        Mon, 19 Sep 2005 22:08:06 -0700 (PDT)

Return-Path: <administrator@dot.com>

Received: from localhost (wi1.laslo.co.uk [69.30.192.150])

        by mx.gmail.com with ESMTP id 15si6929791nzp.2005.09.19.22.08.05;

        Mon, 19 Sep 2005 22:08:06 -0700 (PDT)

Received-SPF: neutral (gmail.com: 69.30.192.150 is neither permitted nor denied by best guess record for domain of administrator@dot.com)

Message-Id: <432f9936.2c4c8025.0a73.63c7SMTPIN_ADDED@mx.gmail.com>

From: Dot.Com Administrator <administrator@dot.com>

To: denty.brayton@gmail.com

Subject: Contact us at once !!!

Date: Mon, 19 Sep 2005 23:59:00 MDT

Please change your password to \"passw1234\" on your dot.com account at once. This is a securty test. If your account password does not change in 15 days. Your account will be banned.

Thank You,

Dot.com Administration .

Looking closely at the email header, you can see the sender’s IP shown in bold. Now ping the sender to get his IP: Click Start > Run > “cmd” and type “ping www.elitec0ders.net” notice that both IPs are the same.
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You can also use webmail.mail.gatech.edu to spoof email by noticing that the FROM: field is editable:
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However, as you already know, the email can be traced back to your account. To view the header of an email from your webmail.mail.gatech.edu account, click on the “Message Source” link while viewing an email.

You can find the ISP of a sender by looking for the source IP of the spoofed sender in a whois IP database. Google “whois IP” and one of the links you will find is:

www.arin.net/whois/
Enter the sender’s IP of the email we sent earlier (69.30.192.150) and you will see something similar to the following:
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Take a screen shot of the ARIN WHOIS Output (Screenshot # 8).
Now you found the email of the person who owns that IP. You can also find out that www.wholesaleinternet.com is the website which promotes the service and you can find contact information there.
Section 9: VoIP Snooping

Introduction


VoIP (voice over IP - that is, voice delivered using the Internet Protocol) is a term used in IP telephony for a set of facilities for managing the delivery of voice information using the Internet Protocol (IP). Voice over IP uses Internet Protocol (IP) to carry voice as packets over a packet-switched data network. Voice information is then sent in digital form in discrete packets rather than in the traditional circuit-switched protocols of the public switched telephone network (PSTN). A major advantage of VoIP and Internet telephony is that it increases operating efficiency, avoiding expensive communication costs and reducing unnecessary expenses that occur with ordinary telephone service. 

VoIP Security


VoIP uses the Internet for phone service, bypassing expensive long-distance communication providers, which results in significant savings. However, as with most technology advancements, if not set up and deployed correctly, a VoIP solution can expose an organization to security breaches (Figure 1). For instance, when VOIP is used externally, gateway technologies convert data packets from the IP network into voice before sending them over a public switched telephone network. When VOIP is used internally, the gateways basically route packetized voice data between the source and the destination. A potential issue is that VOIP gateways can be hacked into by malicious attackers in order to make free telephone calls. In addition, attackers can infiltrate phone conversations and steal confidential data in the same way they would hack an IT system. Spammers can also use denial of service attacks to render the phone system useless. To deploy a VoIP solution, one needs to assure that the solution is safe, secure and protected from outside threats.


Below is a list of typical attacks that a VoIP system might face.

Toll Fraud: The IP version of the classic attack by a person pretending to be an employee or Console Cracking (asking the operator for an outside trunk) to make long distance calls. However, the attacker impersonates a valid user and IP address by plugging in their phone or spoofing the MAC Ethernet address.

Eavesdropping: The attacker sniffs (taps into the LAN wireline or Wi-Fi connection) to intercept voice messages. Available tools such as VOMIT-Voice Over Misconfigured Internet Telephony allow performing this function. 

Call Hijacking: Attacker spoofs a SIP Response redirecting the caller to a rogue SIP address and intercepts the call.

Resource Exhaustion: Also Known As DOS [Denial Of Service] attack. This attack reduces the number of available IP addresses, bandwidth, processor memory, and other router/server functions.

Message Integrity: MIM [Man-In-the-Middle] attack to intercept, alter, or redirect call.

Message Type Attacks: Attacker bombards (repetitive) SIP server with BYE or CANCEL messages or ICMP [Internet Message Control Protocol] "port unreachable" messages.


One possible solution to these attacks is encryption. By encrypting data with complex algorithms and encapsulating VoIP packets in a protocol such as IPSEC, the integrity of both end-users’ data can be guaranteed. An example of secure VoIP is Skype. 

Skype uses AES (Advanced Encryption Standard) – also known as Rijndael – which is also used by U.S. Government organizations to protect sensitive, information. Skype uses 256-bit encryption, which has a total of 1.1 x 1077 possible keys, in order to actively encrypt the data in each Skype call or instant message. Skype uses 1024 bit RSA to negotiate symmetric AES keys. User public keys are certified by the Skype server at login using 1536 or 2048-bit RSA certificates.

VoIP Session Initiation Routine
In VoIP, communication is established through a protocol called SIP. SIP (session initiation protocol), the protocol for VoIP is an application-layer control protocol for creating, modifying, and terminating sessions with one or more participants. When a user agent (UAC), a client wants to initiate a session with another user (UA), it sends an INVITE request to the SIP proxies sever, asking for a session creation. This server then forwards the request to the SIP proxy server (UAS) of the desired user agent. The UAS will in turn send an INVITE request to the user to determine if he wants to accept the invitation. If the callee accepts the invitation, it sends an ACK. The caller sends an ACK to indicate that the handshake is done and session is to be established. The SIP user agent – a combination of the UAC and the UAS – can also allow peer-to-peer calls to be made using a client-server protocol.
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VoIP Session Initiation Routine.
Lab Setup:

There is a computer already setup with the speakers and software needed for one part of this lab.  You will need to setup minisip on your harddrive to be able to establish a VoIP phone call.  You will need to get the microphone from a TA to plug into the computer using your HD.
Minisip


Minisip is a free SIP user agent. It features services such as Secure VoIP, SIP, MIKEY, RTP, SRTP, SDP, Video Telephony, Push-to-talk. This tool can be downloaded here:


http://www.minisip.org
The description from the website says: 

“Minisip is a SIP User Agent ("Internet telephone") developed at KTH currently running on Linux. Keywords: Secure VoIP; SIP; MIKEY; RTP; SRTP; SDP; Video Telephony; Push-to-talk. You can download it for free from the download page.

Minisip is developed by Ph.D and Master students at the Royal Institute of Technology, KTH, Stockholm, Sweden. 

The source code is available as a number of libraries under the GNU Lesser General Public License (LGPL) and applications under the GNU General Public Licence (GPL).“
We will now install minisip on your hd.

Installing Minisip (Physical RedHat WS 4.0 Machine)
Installing minisip is a very tedious job because of all its dependencies and environmental variables needed. For this reason it is recommended that you use a script named minisipsintaller created for you. In order to do so, perform the following steps as root:

· Connect to nas4112

· Go to the Lab3 directory

· Copy the directory named voip to your home directory (/root/)

· # cp –R voip ~/.

· # cd ~/voip/software

· Go to the minisip directory and run the script minisipinstaller:

# cd minisip

# ./minisipinstaller

NOTE: If the script does not finish successfully, you need to run it again since there might be a dependency which is out of order and makes other dependencies fail.
This should take approximately 60-90 minutes. When this finishes, the script should have created a script named runminisip located in the root directory. Run this script which should open minisip without any problem.

Configuring Minisip
Minisip will be configured to work as a P2P (peer-to-peer) VoIP service. This means that there will be no intermediary server that authenticate the user and tell each other IP address to accomplish the connection. Therefore previous knowledge of each other IP address is needed.
To accomplish this, the first step is to open minisip in your RedHat WS4 machine.

# ~/runminisip
If minisip fails to open, delete the file named .minisip-conf in the root’s directory and try again:

# rm ~/.minisip-conf
· Now click File > Preferences. You will see a screen which displays the sip account settings.

· Select the default one (My account) and click on Edit…

· Enter anything you want for the Account name (i.e. VoIP) and enter your SIP URI: as username@YourIPHere. Usually YourIPHere is replaced by the domain of the VoIP provider. You can find your IP by executing the command ifconfig in a shell.

· Now type the IP of the computer you will be connecting to (57.35.6.6).

Your screen should now look similar to the following screen shot.
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· Uncheck the box labeled “Requires authentication” since we are not connecting to an actual proxy server.

· Now hit OK on the “Sip Account settings” 

· Click OK on “minisip – Settings.”

· Now we need to setup the contact information. Right click on the contact window and select “Add a Contact.”

· Enter your group number in the Name, VoIP in Type and enter the root@IPAddress of the computer you are connecting to. 

The contact information window should look like the following figure:
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· Hit OK when done. 

Your minisip is now setup to connect to the presetup computer. However, the presetup computer needs some slight modifications.
Go into the SIP account settings on this computer and change the SIP proxy address to your IP.

Hit OK.

When everything is setup, hit call on minisip on one of the computers and get a screen shot of minisip on the computer receiving the phone call.

Screenshot 1: Minisip receiving phone call.

Have your TA check you of for the VoIP conversation accomplished.

TA CHECKOFF: ______________________      DATE:___________

Hang up the call.
Vomit


Vomit, just in case you were wondering, stands for Voice Over Misconfigured Internet Telephones. Vomit converts a captured package into a wave file. The utility can be downloaded at:


http://vomit.xtdnet.nl/

The description from the web site says:

“The vomit utility converts a Cisco IP phone conversation into a wave file that can be played with ordinary sound players. Vomit requires a tcpdump output file. Vomit is not a VoIP sniffer also it could be but the naming is probably related to H.323.”
On the pre-setup computer (57.35.6.6), open VMWare and start the RedHatWS4 virtual machine.  When this starts, open ethereal and begin capturing packets in promiscuous mode on eth0.

· Establish a VoIP connection again just like you did before.  Have a (one-way) conversation and then hangup.

· Now, back on the virtual machine, stop capturing packets and save it to your home directory (/root) in a file named <group-#>.dump  

· Get a screen shot of Ethereal displaying the connection Invite and ACK.

Screenshot 2: Ethereal displaying SIP Invite and Ack.
On the virtual machine (57.35.6.6), open a shell and cd in to the directory where vomit is located:

# cd /root/vomit/vomit-0.2c/

Now run vomit with the following command:
# vomit –r /root/<group-#>.dump | /root/waveplay-20010924/waveplay –S8000 –B16 –C1
Listen to the output.

Question 1: Were vomit and waveplay able to playback the file?

Question 2: How is the quality of the playback compared to that of the actual conversation?

There are many other interesting things to do with VoIP (like man-in-the-middle, or denial of service).  We chose not to include them in the lab for reasons of length and the methods are very similar to what we have/will cover in other labs.

Appendix A: Further Hardening of Windows TCP/IP Stack

http://www.microsoft.com/mspress/books/sampchap/6418.asp
We can further harden the Windows TCP/IP stack by modifying registry settings.
Configuring Registry Settings 

Goto Start > Run > regedit
Navigate to HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters\:

Set the following values for the following parameters

	Parameter
	Data Value

	EnableICMPRedirect
	0

	SynAttackProtect
	2

	TCPMaxConnectResponseRetransmissions
	2

	TCPMaxHalfOpen
	500

	TCPMaxHalfOpenRetired
	400

	TCPMaxPortsExhausted
	5

	TCPMaxDataRetransmissions
	3

	EnableDeadGWDetect
	0

	EnablePMTUDiscovery
	0

	DisableIPSourceRouting
	2

	NoNameReleaseOnDemand
	1

	PerformRouterDiscovery
	0


Parameters and what they mean :

1. EnableICMPRedirect  When ICMP redirects are disabled (by setting the value to 0), attackers cannot carry out attacks that require a host to redirect the ICMP-based attack to a third party. 

2. SynAttackProtect  Enables SYN flood protection in Windows 2000 and Windows XP. You can set this value to 0, 1, or 2. The default setting, 0, provides no protection. Setting the value to 1 will activate SYN/ACK protection contained in the TCPMaxPortsExhausted, TCPMaxHalfOpen, and TCPMaxHalfOpenRetried values. Setting the value to 2 will protect against SYN/ACK attacks by more aggressively timing out open and half-open connections. 

3. TCPMaxConnectResponseRetransmissions  Determines how many times TCP retransmits an unanswered SYN/ACK message. TCP retransmits acknowledgments until the number of retransmissions specified by this value is reached. 

4. TCPMaxHalfOpen  Determines how many connections the server can maintain in the half-open state before TCP/IP initiates SYN flooding attack protection. This entry is used only when SYN flooding attack protection is enabled on this server—that is, when the value of the SynAttackProtect entry is 1 or 2 and the value of the TCPMaxConnectResponseRetransmissions entry is at least 2. 

5. TCPMaxHalfOpenRetired  Determines how many connections the server can maintain in the half-open state even after a connection request has been retransmitted. If the number of connections exceeds the value of this entry, TCP/IP initiates SYN flooding attack protection. This entry is used only when SYN flooding attack protection is enabled on this server—that is, when the value of the SynAttackProtect entry is 1 and the value of the TCPMaxConnectResponseRetransmissions entry is at least 2. 

6. TCPMaxPortsExhausted  Determines how many connection requests the system can refuse before TCP/IP initiates SYN flooding attack protection. The system must refuse all connection requests when its reserve of open connection ports runs out. This entry is used only when SYN flooding attack protection is enabled on this server—that is, when the value of the SynAttackProtect entry is 1, and the value of the TCPMaxConnectResponseRetransmissions entry is at least 2. 

7. TCPMaxDataRetransmissions  Determines how many times TCP retransmits an unacknowledged data segment on an existing connection. TCP retransmits data segments until they are acknowledged or until the number of retransmissions specified by this value is reached. 

8. EnableDeadGWDetect  Determines whether the computer will attempt to detect dead gateways. When dead gateway detection is enabled (by setting this value to 1), TCP might ask IP to change to a backup gateway if a number of connections are experiencing difficulty. Backup gateways are defined in the TCP/IP configuration dialog box in Network Control Panel for each adapter. When you leave this setting enabled, it is possible for an attacker to redirect the server to a gateway of his choosing. 

9. EnablePMTUDiscovery  Determines whether path MTU discovery is enabled (1), in which TCP attempts to discover the largest packet size over the path to a remote host. When path MTU discovery is disabled (0), the path MTU for all TCP connections will be fixed at 576 bytes. 

10. DisableIPSourceRouting  Determines whether a computer allows clients to predetermine the route that packets take to their destination. When this value is set to 2, the computer will disable source routing for IP packets. 

11. NoNameReleaseOnDemand  Determines whether the computer will release its NetBIOS name if requested by another computer or a malicious packet attempting to hijack the computer's NetBIOS name. 

12. PerformRouterDiscovery  Determines whether the computer performs router discovery on this interface. Router discovery solicits router information from the network and adds the information retrieved to the route table. Setting this value to 0 will prevent the interface from performing router discovery.

Appendix B: Additional Exercise on Protecting Windows Against Denial of Service
Windows provides a built in mechanism to prevent common denial of service conditions such as a UDP Flood. By using the windows firewall, we can configure windows to protect itself against standard off-the-shelf Denial of Service attacks.

On the RedHat 7.2 machine, start datapool

#./datapool.sh –c –d x+2 -l T3 –r updflood

Start Ethereal on the Windows machine.
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Q1: What kind of responses is the Windows machine returning? Why?

Ans : The Windows machine returns ICMP Destination Unreachable messages. This is because the ECHO requests are originating from a random IP address.

Now, on the WinXP machine, go to Start > Settings > Network Connections

Right click on the Local Area Connection > Properties > Advanced

Enable the firewall by ticking the Checkbox “Protect my computer and network by limiting or preventing access to this computer from the internet”
Click the “Settings” button at the bottom of the screen.

In the Advanced Settings dialog that appears click the ICMP tag. 

Ensure that all the options are unchecked.

Click Ok on all windows.
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T. 5 L. 28, 23.T, 355, ECHO— Request
1282678 233.000451 11.28.23.17 57.35.6.168 ECHo  Request
1282679 233.000684 11.28.23.17 57.35.6.168 ECHo  Request
1282680 233.000758 11.28.23.17 57.35.6.168 ECHo  Request
1282681 233.000826 11.28.23.17 57.35.6.168 ECHo  Request
1282682 233.000804 11.28.23.17 57.35.6.168 ECHo  Request
1282683 233.000961 11.28.23.17 57.35.6.168 ECHo  Request
1282684 233.100037 11.28.23.17 57.35.6.168 ECHo  Request
1282685 233.100104 11.28.23.17 57.35.6.168 ECHo  Request
1282686 233.100171 11.28.23.17 57.35.6.168 ECHo  Request
1282687 233.100238 11.28.23.17 57.35.6.168 ECHo  Request
1282688 233.100306 11.28.23.17 57.35.6.168 ECHo  Request
1282689 233.100490 11.28.23.17 57.35.6.168 ECHo  Request
1282600 233.100675 11.28.23.17 57.35.6.168 ECHo  Request
1282601 233.100747 11.28.23.17 57.35.6.168 ECHo  Request
1282602 233.100815 11.28.23.17 57.35.6.168 ECHo  Request
1282603 233.100882 11.28.23.17 57.35.6.168 ECHo  Request
1282604 233.100058 11.28.23.17 57.35.6.168 ECHo  Request
1282605 233.101025 11.28.23.17 57.35.6.168 ECHo  Request
1282606 233.101208 11.28.23.17 57.35.6.168 ECHo  Request
1282607 233.101277 11.28.23.17 57.35.6.168 ECHo  Request
1282608 233.101344 11.28.23.17 57.35.6.168 ECHo  Request
1282600 233.101411 11.28.23.17 57.35.6.168 ECHo  Request
1282700 233111085 11.28.23.17 57.35.6.168 ECHo  Request
1282701 233.111185 11.28.23.17 57.35.6.168 ECHo  Request
L

Frame 1183040 (60 bytes on wire, 60 bytes captured)

Ethernet IT, Src: 00:0C:29:84:Ca:08, DST: 00:0C:20337:47:89

Internet Protocol, src Addr: 11.28.23.17 (11.28.23.17), DSt Addr: 57.35.6.168 (57.35.6.168)

User Datagram Protocal, src Port: echo (73, Dst Port: echo (7)

Echo

7
IS =
[0000 00 Oc 29 37 47 80 00 0c 29 &4 ca 05 08 00 45 00 . .J76. Y
0010 00 26 12 32 00 00 £f 11 47 ob Gb 1c 17 11 35 23 .&.4..
0070 06 a8 00 07 00 07 00 17 00 00 31 32 33 34 35 36 L
0030 37 38 30 30 00 00 00 00 00 00 00 00 50, L
7
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Q2: Does the windows machine respond with any packets? If so, which kinds of packets does it return? If not, why?

Ans: The windows machine does not return any packets, since the firewall blocks all incoming ICMP echo packets.
Q3: Out of the four Denial of Service attacks you have tried, how many does the Windows firewall protect you from?

Ans: 
Teardrop [yes]


UDPFlood [yes]


SYNflood [yes]


Twinge [yes]

Appendix C: Additional Information on Email Spoofing

Sendmail is much pickier about what sort of mail it will send, making it much harder to fake emails. However configuring your sendmail server to be more restrictive about the email it accepts is not sufficient. Why? A prankster or spammer does not need to connect to your mail router, any will do. Since mail may involve multiple steps all that needs to be done is to find one open relay that will forward the email to other, legitimate mail servers. This is an inherent problem with the protocol, but the most common solution is to check the source of a forwarded email against a blacklist.

SMTP however is not the only vulnerability on email. Most email server use POP to retrieve mail from them. 

http://www.faqs.org/rfcs/rfc1939.html
POP however is conducted all in plaintext, including the username and password. Hence a sniffer on the network can recover these usernames and passwords. The solution is to not use POP. An alternative email retrieval protocol, IMAP does not transmit username and password in clear text.

http://www.faqs.org/rfcs/rfc3501.html
Appendix D: SIPSAK Tool*
*This tool as written does not work, but in theory it should work.

What is SIPSAK?

SIPSAK is a small command line tool for developers and administrators of Session Initiation Protocol (SIP) applications. It can be used for some simple tests on SIP applications and devices. SIPSAK supports a wide variety of tests, including user location, and stress tests. It can also be used to manipulate SIP packets on the fly.

Features include the ability to send OPTIONS requests, send text files (which should contain SIP requests), do a traceroute, run a user location test, run a flooding test, run a random character trashed test, interpret and react on test responses, and authenticate with qop supported.

Why is it useful?

SIPSAK is a SIP stress and diagnostics utility that lets you test the capabilities of the SIP server. This allows the network administrator to stress test the system under different operating conditions. 

Download

You can download the tool from http://sipsak.org/#download. This website provides further information on the tool. Its various features, modes of operation and some screen shots of the output.

Remember, always use SIPSAK responsibly. Running it in any of the stress modes puts substantial burden on the network and the server under test.

Features:

SIPSAK can be run in a number of modes. A few important modes are explained below:

- default mode
A SIP message is sent to destination in sip-uri and reply status is displayed. The request is either taken from filename or generated as a new OPTIONS message.

- traceroute mode (-T)
This mode is useful for learning request’s path. It operates similarly to IP-layer utility traceroute(8).

- message mode (-M)
Sends a short message (similar to SMS from the mobile phones) to a given target. With the option -B the content of the MESSAGE can be set. Usefull might be the options -c and -O in this mode.

- usrloc mode (-U)
Stress mode for SIP registrar. sipsak keeps registering to a SIP server at high pace. Additionaly the registrar can be stressed with the -I or the -M option. If -I and -M are omitted sipsak can be used to register any given contact (with the -C option) for an account at a registrar and to query the current bindings for an account at a registrar.

- randtrash mode (-R)
Parser torture mode. sipsak keeps sending randomly corrupted messages to torture a SIP server’s parser.

- flood mode (-F)
Stress mode for SIP servers. sipsak keeps sending requests to a SIP server at high pace.

This lab will be completed using your Red Hat 4.0 WS OS and the pre setup computer in the lab (57.35.6.6).  We will download, install and run SIPSAK on our computer and look for the ethereal output on the pre setup computer.

Those commands which will need to be run on both computers will appear thus:

# ./somecommand –some options
1) Promiscuous mode with Ethereal

a. On the pre setup computer (57.35.6.6) start up Ethereal by opening a terminal and issuing the following command:

# ethereal&

This will start up ethereal and ready it for displaying the packets.

b. Then go to the “Capture” menu, then click the “Options” menu item.  This will open up the configuration page for Ethereal.  Uncheck “Enable network name resolution” and make sure “Capture packets in promiscuous mode” is enabled.  This will ensure that Ethereal is capturing any packets that it may be heading out over the wire, IE “Promiscuous Mode”.
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c. Click the “Capture” button.  Ethereal is now recording all packets on the wire.

2) Now go to your Red Hat 4.0 WS. Make sure a copy of SIPSAK is in your local directory.

a. Execute the command:

# tar –zxvf sipsak-0.9.6-1.tar.gz
# cd sipsak-0.9.6
#./configure;make;make install

This will unzip and compile your copy of sipsak.


b.  Now we are ready to communicate with the Red Hat 4.0 WS on the pre setup computer 

 Execute the following command to send an IM to 57.35.6.6:

# sipsak –B “I can’t let you do that Dave” –s sip:root@57.35.6.6

At this point either you or your partner must monitor the pre setup computer. You will notice that an IM is received. However, minisip sometimes might fail because its protocol isn’t compatible

Take an ethereal output at the pre setup computer.

c. Execute the command

# sipsak –F –s sip:root@57.35.6.6

This command will flood the connection with an OPTIONS request causing the pre setup computer to overload. Again take an ethereal screen capture at the pre setup computer to view this buffer overflow.

Appendix E: Investigating PayPal/Ebay/Bank Account Phishing

What is Phishing

Phishing is a form of social engineering, characterized by attempts to fraudulently acquire sensitive information, such as passwords and credit card details, by masquerading as a trustworthy person or business in an apparently official electronic communication, such as an email or an instant message. The term phishing arises from the use of increasingly sophisticated lures to "fish" for users' financial information and passwords. (wikipedia: Phishing) 

Most methods of phishing use some form of technical deception designed to make a link in an email appear to belong to the spoofed organization. Misspelled URLs or the use of subdomains are common tricks used by phishers, such as this example URL, http://www.yourbank.com.example.com/. 

Spoofing links with web addresses containing the @ symbol, which were used to include a username and password in a web URL. For example, the link http://www.google.com@members.tripod.com/ might deceive a casual observer into believing that the link will open a page on www.google.com, whereas the link actually directs the browser to a page on members.tripod.com, using a username of www.google.com; were there no such user, the page would open normally. 

Some phishing scams use javascript commands in order to alter the address bar. This is done either by placing a picture of the legitimate entity's URL over the address bar, or by closing the original address bar and opening a new one containing the legitimate URL.

Internationalized domain names (IDN) in web browsers, might allow visually identical web addresses to lead to different, possibly malicious, websites.

      Some common ways of identifying a phisher’s email are the following:

· Hyperlinks on the email go to suspicious urls

· Phisher didn’t bother spoofing the email (correcting the reply-to email address)

· Emails that require re-authorization, re-verification of sensitive information

· Spelling errors

Whois lookup
· Since the email address is more than likely spoofed, we will want to look for the original sender. View the source of a phishing email. (webmail: click “Message Source”, gmail: “More Options” ( “Show Original”, thunderbird: open the e-mail, “View” -> “Message Source”, outlook express: right-click email -> “Properties” -> “Details” tab)

· If the URL looks clean (the url does not include any information that might trace back to your email address), then open a web-browser and view the fake page. [image: image13.png]‘Documents%io20and220Settings;
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(envelope-fron service@paypal.con)
Received: from hormell.zatech.edu (hormell.prism.gatech.edu [130.207.171.111)
(using TLSvl with cipher EDH-RSA-DES-CBC3-SHA (168/168 bits))
(Client CN "hormell.prism.gatech.edn”, Issuer "Tech Support CA" (verified 0K))
by deliveratorf.zatech.edn (Postfix) with ESHTP
id 78E532B57; Sun, 5 Feb 2006 20:05:55 -0500 (EST)
(envelope-fron service@paypal.con)
Received: from ([130.207.171.121])
by hornell.zatech.edn with ESHTP with TLS id KP-BRAPX.41725021;
Sun, 05 Feb 2006 20:05:38 -0500
Received: from deliveratorl.zatech.edu (localhost [127.0.0.1])
by localhost (Postfix) with ESHTP
id 567351FAB81; Sun, S5 Feb 2006 20:05:38 -0500 (EST)
(envelope-fron serviceBpaypal.con)
ad; 1

Reply-To: <service@paypal.con>
From: "PayPal.lInc" <service@aypal.com>
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Figure 1. IP of phiser
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NetNawe:  SEC065248111096030826

NetHandle: NET-68-248-111-96-1

Parent: NET-65-245- 1

NetType Reassignead

Comment:  For Policy lbuse issues, contact: abuse@subell.net
Corment For Technical issues, contact: nocBswbell.net
RegDate:  2003-08-26

Upaated:  2003-08-26

RTechHandle: IPADN3-RRIN
RTechNen: IPAdmin-hmeritech

RTechPhone: +1-800-648-1626

RTechEmail: IPAdmin-hmeritech@sbis.sbe.com

OrghbuseHandle: ABUSEG-ARIN

OrghbuselNeme:  Mbuse - Southuestern Bell Internet
+1-800-648-1626
abuseBsbeglobal.net
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# IRIN WHOIS datebase, last updated 2006-02-05 19:10
# Enter 2 for additional hints on searching ARIN's WHOIS database.

@ Internet





Figure 2. An example of the whois lookup on the IP registrator. Information on the IP that sent the phishing email.

Answer Sheet Lab 3

Group Number: _______________

Member Names: _________________________     _________________________

Section 1: MAC address spoofing

Q1.1:  What would happen if two hosts on the same network had the same MAC address?


Q1.2:  Although it is relatively simple to forge a MAC address, it is very difficult to determine the MAC address of a host on a subnet to which you do not already have access. Why is this true? 

Section 2: IP spoofing from Windows

Q2.1. What machines appear to be involved in the daytime-udp query? Who is    querying whom, and who is answering whom? 

Q2.2. For every packet injected, how many appear in Ethereal?  Explain.

Q2.3. Note the destination IP address of your spoofed packets. How do other groups working on this lab affect the attack? (Note: this is known as a smurf attack)

Q2.4. Was this an example of blind or non-blind IP spoofing? Why?

Section 3: IP spoofing from a Linux machine

3.1 UDP Spoofing
Q3.1.1. Copy a sample line from your Ethereal output. What machines appear to be the source and destination of this transmission? 

Q3.1.2. What code changes were necessary?

Q3.1.3. Copy the ASCII representation (bottom right display from Ethereal) of your created packet. 

3.2 TCP Spoofing
Screenshot #1 – Take a screen capture of your ethereal output.

Q3.2.1 What code changes were necessary?

Screenshot #2 – Take a screen capture that shows the highlighted packet.

Section 4: DNS Spoofing and Denial of Service

Q4.1:  What are the results of trying to reach Microsoft’s Windows Updater?

Q4.2:  In the case of our local network, you may have had to try this several times. Why? (Hint: Observe transactions in Ethereal)

Q4.3:  Copy the output of DNSSpoof

Q4.4:  Keeping in mind that this attack is only possible if executed between a host and its DNS server, state three instances in which a hacker could use this attack. (You may wish to consider this with respect to the Blaster worm, or with respect to the Georgia Tech LAWN’s logon page). 

Section 5: Monitoring for Spoofing Attacks
Q5.1:  Copy the arpwatch output. 

Q5.2:  Copy the new arpwatch output.

Section 6: TCP Spoofing and Denial of Service
Q6.1:  Describe the tcpkill output. What are the numbers represented in the output? (Hint: you may want to correlate these messages with the Ethereal output)

Q6.2:  Although this is a simple attack, it cannot be used by a hacker to arbitrarily break Internet connections. Why not?

Q6.3: E-mail spoofing occurs when the header of an e-mail message is changed so that the message appears to have originated from somewhere else. This is a technique that most spammers use. Why is e-mail spoofing possible? (Hint: look at the protocols that allow e-mail communication)
Section 7: Denial of Service Attacks

Q7.1:  Were you able to execute commands from your first FTP session? Were you able to execute commands in your second FTP session? Why or why not?

Q7.2:  Describe your Ethereal output. What sources appear to be sending data to your FTP server? How is your FTP server reacting? Are its responses consistent? 

Q7.3:  Were you able to create an FTP session? Why or why not?

Q7.4:  Describe your Ethereal output

Q7.5:  Describe your Ethereal output. 

Q7.6:  What is the rate of UDP traffic generation in Mbps?

Q7.7:  Assume that a victim server has a 1Gbps connection to the network. In a distributed DoS attack, how many of your traffic generators would be necessary to completely overwhelm this connection? (Note: In a real world attack nowhere near this many is required, as this is an extremely inefficient generator and networks may fail from a buildup of collisions at as little as 60% utilization). 

Q7.8:  Were you able to execute commands from your first FTP session? Were you able to execute commands in your second FTP session? Why or why not?

Q7.9:  Were you able to create an FTP session? Why or why not?

Q7.10:  Describe your Ethereal output.

Q7.11:  Compare and contrast the relative effectiveness of the four attacks.

Section 8: Email Spoofing
8.1 Sendmail Spoofing

Screenshot #5 Attach a screenshot of the above session

Screenshot #6 Take a screenshot of pine showing both the messages
8.2 Spoofing Emails through Remailers

Take a screenshot of the faked email you received (Screenshot #7).
Take a screen shot of the ARIN WHOIS Output (Screenshot # 8).

VOIP Section

Question 1: Were vomit and waveplay able to playback the file?
Question 2: How is the quality of the playback compared to that of the actual conversation?

How long did it take you to complete this lab? Was it an appropriate length lab? 

What corrections and or improvements do you suggest for this lab? Please be very specific and if you add new material give the exact wording and instructions you would give to future students in the new lab handout. You may cross out and edit the text of the lab on previous pages to make minor corrections/suggestions. General suggestions like add tool xyz to do more capable scanning will not be awarded extras points even if the statement is totally true. Specific text that could be cut and pasted into this lab, completed exercises, and completed solutions may be awarded additional credit. Thus if tool xyz adds a capability or additional or better learning experience for future students here is what you need to do.  You should add that tool to the lab by writing new detailed lab instructions on where to get the tool, how to install it, how to run it, what exactly to do with it in our lab, example outputs, etc. You must prove with what you turn in that you actually did the lab improvement yourself. Screen shots and output hardcopy are a good way to demonstrate that you actually completed your suggested enhancements. The lab addition section must start with the title “Lab Addition”, your addition subject title, and must start with a paragraph explaining at a high level what new concept may be learned by adding this to the existing laboratory assignment. After this introductory paragraph, add the details of your lab addition.

Turn-in Checklist
Answer Sheet

4 attachments of MAC addresses

8 screen shots
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